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HƯỚNG DẪN THỰC HÀNH TIN HỌC CĂN BẢN 
(BÀI SỐ 2) 

 
 
 

 
A.​ NỘI DUNG: 
 

I.​Định lề trang in (Margins). 
II.​ Định dạng Font (Font, Size, Style,…). 
III.​ Cách bật, tắt kiểu gõ Tiếng Việt. 
IV.​ Chèn (Insert) ký hiệu đặc biệt, thao tác cắt (Cut), dán (Paste), sao 

chép(Copy). 
V.​Các chức năng nhập văn bản tự động (AutoText và AutoCorrect), tìm 

kiếm và thay thế (Find and Replace) . 
VI.​ Định dạng đoạn (Paragraph). 
VII.​ Bổ sung các thao tác trên tập tin (Open,.., Save, Save as, Close). 
 

B.​ HƯỚNG DẪN: 
I.​Định dạng lề trang in : 

B1: File\ Page Setup, xuất hiện hộp thoại: 
B2: Vào thẻ Margins (để xác định các lề trang giấy): 

●​ Top: 2.5cm: Chừa trống từ trên xuống = 2,5cm. 
●​ Bottom: 2.5cm:   “         từ dưới lên = 2,5cm. 
●​ Left: 3.5cm:        “         từ trái qua  = 3,5cm. 
●​ Right: 2.5 cm:     “         từ phải qua = 2,5cm. 

(Các số trên chỉ là thí dụ. Ta có thể chọn TD: Trên 2, dưới 
2, trái 3, phải 2cm).  
     B3: Vào thẻ Paper: chọn khổ giấy A4. 
     B4: Click Mouse vào Default (ngầm định) nếu muốn  

lưu lại cấu hình cho lần sử dụng sau. 
     B5: OK . 

II.​   Định dạng Font cho văn bản : 
B1: Format\ Font xuất hiên hộp thoại :            
B2: Trong thẻ Font chọn loại Font tương thích ​

             với bảng mã đã được kích hoạt trước. 
Ví dụ : Tương ứng từng bảng mã ~ Font tương ứng 
Unicode : Times new roman, Tahoma, Arial… 
VNI windows : VNI_...;Vietware_F :  SVN… 
Vietware_X :    VN…  ; TCVN3 :         .Vn… 
​ B3: Font Size: Kích cỡ chữ. (TD: Size = 12..). 

B4: Font style : kiểu hiển thị của font chữ. 
Regular: chữ bình thường. Italic: chữ nghiêng. 
Bold: chữ đậm. Bold Italic: đậm nghiêng. 
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Underline: gạch dưới. 
(Ghi chú: Có thể sử dụng phím tắt: Ctrl + I, Ctrl + B, 
Ctrl + U). 

B5 : Chọn hiệu ứng nếu cần (Effects): 
​ + STRIKETHROUGH:​ Gạch 1 đường ngang giữa các ký tự- 

+ DOUBLE STRIKETHROUGH:​ Gạch 2 đường ngang giữa các ký tự  
​ + SUPERSCRIPT: Chỉ số trên : TD: X2 + Y3 +1 = Z-1/2. (Phím tắt: Ctrl+ Shift+ =). 
​ + SUBSCRIPT: Chỉ số dưới : TD: H2O. (Phím tắt: Ctrl+ =). 

​ + Chữ bóng: TD: Shadow. Chữ viền : TD: OUTLINE   

​ + Chữ chạm nổi: TD: EMBOSS​ + Chữ chạm chìm: TD: ENGRAVE 
​ + Chữ Hoa nhỏ : TD: Small Caps​ ​ +  Chữ Hoa:  TD: all caps. 
​ + Hidden: ẩn ( không cho hiện ký tự). Để xem các ký tự ẩn ta vào Tools\ Options\ View 

và chọn Hidden text. (Hidden: Prevents selected text from being displayed. To view hidden text, 
on the Tools menu, click Options, and on the View tab, select the Hidden text check box ). 

B6: Default. Chọn Yes/ OK.  
​ Default: lưu các thông số vừa chọn thành các giá trị mặc nhiên hay ngầm định cho tài liệu 

hiện hành và mọi tài liệu mới có cùng dạng mẫu. (Default : Click to store the current values on 
the Font, Character Spacing, and Text Effects tabs as default settings for the active document 
and all new documents based on the current template.). 

III.​ Cách bật, tắt kiểu gõ Tiếng Việt: Vào UNIKEY... Xem hướng dẫn.(Cách khởi 
động chương trình gõ tiếng Việt. Cách đóng hoặc chuyển cách gõ Việt qua Anh…Cách 
khắc phục khi gõ tiếng Việt bị khoảng trắng…). 

IV.​ Chèn, cắt, dán, copy… các đối tượng đặc biệt : 
1.​ Chèn (Insert): Picture (hình ): 

B1: Đặt con trỏ vào vị trí muốn chèn hình vào. 
B2:  Vào Insert\ Picture \Clip Art (chèn những hình 
có sẵn trong thư viện của Microsoft Word) hoặc      
…. \ From File (chèn những hình tự tạo, hình 
download, hình vẽ…) để chọn hình cần chèn. 
B3: Click chuột vào Insert.​
                 2) Copy: Tạo bản sao theo các bước: 
Chọn Hình/ Copy(Ctrl+C)/ Đặt trỏ/ 
Paste(Ctrl+V). 

3) Cut: Như Copy nhưng hình cũ bị xoá 
hay cắt. 
 
*Ghi chú các phím tắt thường dùng trong WORD (xem thêm ghi chú ở trang 113): 
 

To do this Press To do this Press 

Create a nonbreaking space. CTRL+SHIFT+SPACEBAR Copy the selected text or 
object. CTRL+C 

Create a nonbreaking hyphen. CTRL+HYPHEN Cut the selected text or object. CTRL+X 

Make letters bold. CTRL+B Paste text or an object. CTRL+V 

Make letters italic. CTRL+I Undo the last action. CTRL+Z 
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Make letters underline. CTRL+U Redo the last action. CTRL+Y 

Decrease font size. CTRL+SHIFT+< Increase font size. CTRL+SHIFT+> 

Remove paragraph or 
character formatting. CTRL+SPACEBAR   

*Chèn ký tự đặc biệt (symbol): 
TD1: Cho chèn  vào các ký hiệu sau : ​ ​ µ​ ≥ 

Hướng dẫn cách chèn thêm các ký hiệu, dấu hiệu (Symbols) vào một văn bản: 
​ B1: Đặt con trỏ vào vị trí muốn chèn . 
​ B2: Vào Insert\ Symbol, hộp thoại xuất hiện. Trong hộp Font chọn Webdings. Chọn ​
hình cần chèn. 
​ B3: Click chuột vào Insert. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 ​ ​ ​ ​ µ​ ​ ≥ 
 
​ TD2: Cho chèn  vào các ký hiệu sau:​ 
​ Hướng dẫn 1: ​+ Vào Insert\ Symbols\ Symbol chọn  và Click vào Insert: 
​ ​ ​ ​ TD: ​ 
​ ​ ​ + Dùng chuột trái hoặc bàn phím (Shift+) để chọn cả 4 ký hiệu rồi Copy 
vào Clipboard (= chọn “Copy” hay “Ctrl + C”) xong thực hiện lệnh Paste( hay “Ctrl+ V”) ... để 
có các hàng ký hiệu như sau: 

 
​ ​ ​  
​ ​ ​ ​  
​ ​ ​ ​ ​  
​ Hướng dẫn 2:​ + Vào Insert\ Symbols\ Old English Text MT chọn và Insert các ký tự sau: 
​ ​ ABCDEFGHIJKLMNOPQRSTUXZ 
​ Hướng dẫn 3:​ + Chọn (quét đen) một vài ký hiệu do bạn làm để thử lệnh Delete/ Undo. 
 

V.​Nhập văn bản tự động bằng AutoText và AutoCorrect. Tìm kiếm và thay thế: 
1.​ AutoText  :  

Dùng để chèn nhanh một đối tượng văn bản hay hình ảnh, thường 
xuyên lặp đi lặp lại. 

*Chuẩn bị: 
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B1: Chọn đối tượng cần tạo AutoText (bao khối trước) 
B2: Vào Insert\ AutoText\ AutoText 
B3: Nhập ký tự đại diện vào mục Enter AutoText entries here  
B4: Click nút Add để hoàn thành. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* Để chèn đối tượng văn bản vừa tạo bằng AutoText vào tài liệu: 
B1: Đặt con trỏ tại vị trí cần chèn 
B2: Vào Insert\ AutoText\ AutoText. 
B3: Nhập ký tự đại diện vào mục Enter AutoText entries here  
B4: Click vào nút Insert để chèn đối tượng vào tài liệu  
B5: OK để đóng hộp thoại lại. 

* Cách xoá đối tượng trong AutoText:  
+ Tương tự như chèn nhưng ở bước 4 : Click vào nút Delete. 

 
2.​ AutoCorrect :  
Tương tự AutoText cũng chèn nhanh một đối tượng văn bản bằng cách sử dụng 
ký tự đại diện thay thế. 
* Chuẩn bị: 

B1: Vào Tools\ AutoCorrect options 
B2: Hộp thoại xuất hiện  
B3: Replace: nhập ký tự đại diện  
​ With : Nhập đoạn văn bản cần thay thế. 
B4: Click Nút Add để hoàn thành 
 
 

* Để dùng chức năng AutoCorrect  
B1: Đặt con trỏ ở vị trí cần chèn. 
B2: Đánh ký tự đại diện vào 
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B3: ENTER. (Thì lập tức đoạn văn bản sẽ thay thế ký tự đại diện.) 
Ví dụ: Chúng ta nhập ký tự là DHTD và  ENTER thì nó sẽ được thay thế là : 
ĐẠI HỌC TÂY ĐÔ. 

 
*  Để xoá đối tượng trong AutoCorrect: Thao tác tương tự lúc xoá một AutoText. 

 
 

​
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.​ Tìm kiếm và Thay thế (Find and Replace): 
* Tìm Kiếm: 

Bạn có thể nhanh chóng  tìm ra sự xuất hiện của một từ hay cụm từ cụ thể: 
​ 1. Trên menu Edit, Click vào Find. 
​ 2. Ở hộp thoại Find What, gõ vào từ hay cụm từ bạn muốn tìm. 
​ 3. Chọn bất kỳ tùy chọn khác nào nếu muốn. 
​     Để chọn cùng lúc, tất cả các trường hợp của một từ hay cụm từ cụ thể, Click chọn hộp 
kiểm soát  Highlight all items found in, kế đến bạn có thể chọn phần ( đầu, đuôi, giữa) của tư 
liệu mà mình muốn tìm trong đó khi kích chuột vào Highlight all items found in list. 
​ 4. Nhắp chuột vào Find Next hoặc Find All. 

* Nếu không muốn tìm nữa thì nhấn ESC. 
(Tiếng Anh Tham Khảo:You can quickly search for every occurrence of a specific word or 
phrase. 

1.​ On the Edit menu, click Find.  
2.​ In the Find what box, enter the text that you want to search for.  
3.​ Select any other options that you want.  

To select all instances of a specific word or phrase at once, select the Highlight all items 
found in check box, and then select which portion of the document you want to search in 
by clicking in the Highlight all items found in list. 

       4).  Click Find Next or Find All. To cancel a search in progress, press ESC.). 
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* Thay Thế (Replace): 

Bạn có thể tự động thay thế “chữ”—Thí dụ: thay thế chữ “Acme” bởi chữ “Apec”. 
1.​ Trêm Menu Edit, click Replace.  
2.​ Ở hộp thoại Find what, gõ vào “chữ” bạn muốn tìm.  
3.​ Ở Replace with, gõ vào “chữ” thay thế.  
4.​ Chọn bất kỳ tùy chọn khác nào nếu muốn (xem phần 3 ở mục Tìm kiếm).  
5.​ Nhấp chuột vào Find Next (tìm chữ tiếp theo), Replace, hoặc Replace All (thay tất cả).  

* Nếu không muốn tìm nữa thì nhấn ESC. 
(Tiếng Anh Tham Khảo: You can automatically replace text— for example, you can replace 
"Acme" with "Apex". 

1.​ On the Edit menu, click Replace.  
2.​ In the Find what box, enter the text that you want to search for.  
3.​ In the Replace with box, enter the replacement text.  
4.​ Select any other options that you want.  
5.​ Click Find Next, Replace, or Replace All.  

To cancel a search in progress, press ESC.). 
VI. Định dạng đoạn (Paragraph):   
B1: Chọn đoạn văn bản cần định dạng. 
B2: Vào Format\ Paragraph, hộp thoại​
xuất hiện. 
B3 : Chọn thẻ Indents and Spacing  
 + Mục Alignment: Chọn lề cần canh 

●​ Left : Lề trái 
●​ Right : Lề phải 
●​ Centered : Giữa 
●​ Justified : Canh đều 

       + Mục Indentation : Thụt dòng  
●​ Left : Lề trái. Right : Lề phải 
●​ Special : first line : dòng đầu tiên. Hanging : các dòng còn lại. 

        + Mục Spacing : khoảng cách  
●​  Before : khoảng cách giữa dòng đầu tiên và đoạn trước đó. 
●​ After : khoảng cách giữa đoạn trước và đoạn sau. 
●​ Line Spacing : khoảng cách giữa các dòng. 

■​ single : dòng đơn 
■​ 1.5 line : gấp rưỡi. Double : gấp đôi. 

VII. Ôn, bổ sung các thao tác trên tập tin :  
●​ OPEN (mở):  
Dùng để mở một tập tin để xem hoặc sửa chữa. 

B1: Vào File\ Open  hoặc (Ctrl+ O). 
B2: Hộp thoại xuất hiện  

●​ Look In : vị trí lưu tài liệu 
B3: Chọn tài liệu cần mở (Open). 

●​ SAVE (Lưu tài liệu ):Dùng để lưu một tập 
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tin cũ sau khi đã sửa chữa . 
B1: Vào File\ save  hoặc (Ctrl + S). 

●​ Nếu save lần đầu tiên thì hộp thoại 
 xuất hiện 
●​ Save in: chọn vị trí để lưu tài liệu. 

B2: File Name : đặt tên cho tài liệu 
B3: Click nút Save. 

●​ SAVE AS (Lưu như…): 
Dùng để lưu một tập tin mới hoặc để lưu một tập tin cũ với tên khác hoặc ở 
chỗ mới. 

●​ CLOSE : đóng tập tin lại sau khi lưu tài liệu xong. Nếu không muốn lưu tài liệu lại thì 
chọn mục Cancel. 

  
 

   
 
​   
 
 
 
 
 
 
 
 
 
 

C.​ Bài Tập THỰC HÀNH TRÌNH BÀY VĂN BẢN: 
​ (Nội dung các đoạn văn, thơ…dưới đây chỉ là các thí dụ để bạn tập, rèn cách gõ, trình bày 
văn bản. Bạn có thể thay bằng bất cứ đoạn văn, thơ nào khác vừa hay, vừa bổ ích mà bạn thích.) 

●​ FBài thực hành số 1: 
 

1.​ Định lề trang in (File\ Page Setup) theo các kích thước sau: 
Top : 2cm, Bottom : 2cm, Left : 3cm, Right : 2cm 
Khổ giấy : A4 

2.​ Tạo văn bản (với Font: Times New Roman, Size=12) có dạng như sau: 
      (Hướng dẫn: Vào Insert\ Symbol  chọn font Wingdings  để chèn các biểu tượng &,  ,   ) 
 
CHÂN DUNG NHÀ KHOA HỌC 
“Ước mơ của em: nhà khoa học tương lai…”. Nhưng có lúc nào bạn tự hỏi mình: Thế nào là nhà 
khoa học? 
Song còn câu trả lời độc đáo của bạn trẻ Việt Nam thì sao, nhất là câu trả lời rất riêng của chính 
bạn? 
 
&      
Câu hỏi này đã được 2.500 học sinh từ 10 đến 17 tuổi ở Ấn Độ, Chilê, Pháp, Mỹ, Ý, Mêhicô, 
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Braxin và Nigiêria trả lời qua những bức tranh tham gia cuộc thi vẽ chân dung nhà khoa học. Lạ 
làm sao khi hầu hết đều vẽ nhà khoa học như một người… đeo kính trắng dày cộm, tóc tai bù xù 
và lúc nào cũng khoác áo choàng trắng, bận bịu với lĩnh kĩnh những chai lọ cùng ống nghiệm và 
luôn làm việc đơn độc,….. 
   
Giáo sư Leopoldo de Meis, người có sáng kiến mở ra cuộc thi này, nhận xét: “Đó là chân dung 
của người kỹ thuật viên phòng thí nghiệm, hay của những người làm nghề giả kim hồi thế kỷ 18, 
19 chứ nào phải là nhà khoa học!”. Theo giáo sư, có lẽ các bạn trẻ đã “thừa hưởng” hình ảnh ấy 
từ các phim hoạt hình và truyện tranh. 
  (   
Trong khi đó 90 bạn trẻ tham gia cuộc thi Châu Âu dành cho các nhà khoa học trẻ (từ 15 đến 21 
tuổi) lại trả lời bằng chính sản phẩm nghiên cứu của mình như các tác giả đoạt ba giải nhất đồng 
hạng của cuộc thi lần thứ 10 diễn ra tại thành phố Porto bên Bồ Đào Nha, đã tạo ra chương trình 
tin học biến đổi các ảnh chụp từ máy kỹ thuật số thành những ảnh ba chiều hay chiếc gậy có đầu 
dò siêu âm giúp người mù phát hiện chướng ngại cách 5m trên đường đi, hay tìm ra nguyên nhân 
sơn trắng bị ố vàng trong bóng tối từ đó tạo ra các chất thêm vào sơn để chống hiện tượng này. 
{ & { 
 

3.​ Di chuyển câu “Song còn câu trả lời độc đáo của bạn trẻ Việt Nam thì sao, 
nhất là câu trả lời rất  riêng của chính bạn?” đến cuối tài liệu trên (dùng thao 
tác cắt và dán). 

4.​ Dùng thao tác chép và dán để tạo ra dòng sau vào cuối tài liệu: 
    ♦ ♥ ♣ ♠  ♦ ♥ ♣ ♠  ♦ ♥ ♣ ♠  ♦ ♥ ♣ ♠  ♦ ♥ ♣ ♠  
    Hướng dẫn: - Chèn 4 ký hiệu ♦ ♥ ♣ ♠ vào tài liệu (Font: Symbol). 
​ ​ - Chép (Edit \ Copy) 4 ký hiệu trên vào Clipboard. 
​ ​ - Thực hiện thao tác dán (Edit \ Paste) 5 lần 

5.​ Chọn khối là đoạn thứ nhất, nhấn phím Delete. Nhận xét. Thực hiện thao tác 
Undo. Nhận xét. 

6.​ Chọn khối là toàn bộ tài liệu (nhấn tổ hợp phím Ctrl + A), nhấn phím Delete. 
Nhận xét. Thực hiện thao tác Undo. Nhận xét. 

7.​ Tiếp tục thực hiện thao tác Redo. Nhận xét. 
8.​ Lưu tài liệu lên trên đĩa D: với tên Buoi2_1.doc 
9.​ Đóng cửa sổ tài liệu đang mở. 
10.​ Mở xem lại tài liệu vừa lưu. 
 

●​ FBài thực hành số 2: 
Nhập và định dạng cho các đoạn văn bản dưới đây, sau đó lưu vào đĩa D: với tên 

Buoi2_2.doc 
 

HỘP HỘI THOẠI FONT 
Nếu bạn muốn chọn những Font chữ khác nhau cho các ký tự, chỉ định in đậm (Bold), in 
nghiêng (Italic), hay gạch dưới (Underline) thì ta có thể chọn lệnh trên thanh Format. Tuy nhiên 
Word còn cung cấp rất nhiều kiểu định dạng khác cho các ký tự như: chỉ số trên Superscript (a2 + 
b2), chỉ số dưới Subscript (H2SO4), chữ bóng Shadow, chữ viền Outline,… những định dạng này 
mặc nhiên không có nút lệnh trên thanh công cụ. Do đó để sử dụng thì phải sử dụng hộp hội thoại 
Font. (Format\ Font…) 
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Sau khi chọn khối văn bản cần định dạng, bạn chọn lệnh Format\ Font. Hộp thoại Font gồm có 
các thành phần sau: 
Lớp Font​ : chọn Font chữ 

Font​ ​ : cho phép nhập hay chọn Font chữ cho các ký tự. 
Font style​ : liệt kê các kiểu chữ: Regular, Italic, Bold, Bold Italic. 
Size​ ​ : cho phép nhập hay chọn cỡ chữ. 
Underline​ : cho phép chọn kiểu gạch dưới. 
Font color​ : cho phép chọn màu cho các ký tự. 
Strikethrough​ : gạch một đường giữa các ký tự. 
Double strikethrough: gạch hai đường giữa các ký tự. 
Superscript ​ : chỉ số trên (a2 + b2). 
Subscript​ : chỉ số dưới (H2SO4). 
Shadow​ : chữ có nét bóng. 
Outline​​ : chữ có nét VIỀN xung quanh. 
Emboss​: Emboss chữ CHẠM NỔI. 
Engrave​ : Engrave chữ CHẠM CHÌM. 
Small Caps​ : Small Caps chữ HOA NHỎ. 
All Caps​ : All Caps chữ HOA LỚN. 
Hidden​​ : ẩn (không cho hiện ký tự). 
Preview​ : khung hiển thị minh hoạ. 
OK​ ​ : áp dụng cho thông số vừa chọn cho ký tự. 
Default​​ : lưu các thông số vừa chọn thành gíá trị mặc nhiên. 
Cancel​ ​ : hủy bỏ các thông số vừa chọn. 

Lớp Character Spacing: định khoảng cách giữa các ký tự. 
Lớp Text Effects: chọn các hiệu ứng động cho các ký tự. 

 

●​ FBài thực hành số 3: 
 
1.​ Tạo 2 mục AutoText (có thể dùng Insert\ AutoText\ AutoText\ AutoCorrect) như sau: 

    Tên mục​ ​ Nội dung 
      kv​ khu vực 
      db​ ĐBSCL 

2.​ Nhập nội dung văn bản như sau (sử dụng mục AutoCorrect vừa tạo): 
Đồng bằng Sông Cửu Long: Tiềm năng chưa được khai thác ​
 

ĐBSCL gồm 13 tỉnh, thành phố có diện tích đất gần 40.000 km2, dân số khoảng 17 triệu người; 
là vùng châu thổ phì nhiêu  hàng năm cung cấp trên 50% sản lượng lương thực, thuỷ sản, trái 
cây cho cả nước. Những năm gần đây, các tỉnh khu vực ĐBSCL  đã tạo môi trường đầu tư ngày 
càng hấp dẫn để thu hút nguồn vốn đầu tư trực tiếp nước ngoài (FDI), khai thác hiệu quả tiềm 
năng phong phú này. 
 
Nỗ lực thu hút đầu tư 

Sau thời gian trầm lắng, trong những tháng cuối năm 2004 và quý I-2005, tình hình thu hút 
đầu tư nước ngoài vào khu vực ĐBSCL đã có dấu hiệu tăng trở lại. Theo số liệu mới nhất từ 
Cục Đầu tư nước ngoài- Bộ Kế hoạch và Đầu tư, FDI của khu vực ĐBSCL đạt xấp xỉ 1,4 tỷ 
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USD với 179 dự án. 3 tỉnh dẫn đầu về thu hút đầu tư nước ngoài là Long An 644 triệu USD; 
Kiên Giang 454 triệu USD; Cần Thơ 112 triệu USD. Cục Đầu tư nước ngoài cũng nhận định 
các tỉnh có sự cải thiện đáng kể trong thu hút đầu tư là Tiền Giang, Bến Tre, Vĩnh Long, An 
Giang, Bạc Liêu và Trà Vinh……. 

Những tiềm năng vẫn đang vẫy gọi  
Với một tiềm năng phong phú và đa dạng, ĐBSCL vẫn đang tiếp tục mời gọi đầu tư  nước 
ngoài nhằm phát huy hết lợi thế của mình. Hiện nay, thế mạnh của khu vực vẫn là nông, thuỷ 
hải sản. Diện tích gieo trồng lúa của khu vực ĐBSCL đã đạt xấp xỉ  4 triệu ha với sản lượng 
17-18 triệu tấn thóc, đóng góp 4,1 triệu tấn gạo xuất khẩu (năm 2004). Với sản lượng lúa gạo  
khá cao, nhưng năng suất và chất lượng còn thấp, công nghệ chế biến bảo quản sau thu hoạch 
còn lạc hậu. Đây chính là mảnh đất màu mỡ mà các nhà đầu tư chưa khai thác, nhất là các nhà 
đầu tư nước ngoài có công nghệ chế biến, thu hoạch và tổ chức hệ thống phân phối. Đối với 
ngành thuỷ sản, với sản lượng 1,44 triệu tấn, ĐBSCL đang có một sức hấp dẫn các nhà đầu tư 
nước ngoài. Khá nhiều các dự án FDI vào ngành thuỷ sản đã được các tỉnh cấp phép. Điển 
hình như tại Bến Tre, sau hội nghị xúc tiến đầu tư tại TP.HCM, UBND tỉnh Bến Tre đã tiếp 
nhận nhiều dự án FDI đối với ngành thuỷ sản như Công ty Peabody Asia Ltd, Công ty 
Dragon International, Công ty Living Ocean International, Công ty liên doanh dinh dưỡng 
nông nghiệp quốc tế…, trong đó nhiều dự án đã được cấp phép trong quý I-2005 này. ….​
​ ​ ​ (Trích từ nguồn Internet Báo Hài Quan mục Nghiên cứu trao đổi). 
Thực hành tiếp:​ ​ ​ ​ ​ ​ (13/05/2005 11:00). 
3.​ Sử dụng chức năng tìm kiếm và thay thế (Edit\ Replace), tìm cụm từ “ĐBSCL” và thay 

thế bởi “Đồng Bằng Sông Cửu Long”. 
4.​ Lưu tài liệu trên đĩa D: với tên Buoi2_3.doc 
5.​ Đóng cửa sổ tài liệu đang mở. 
6.​ Xoá các mục AutoText vừa tạo. 

1.​ Nhập vào nội dung văn bản bên dưới: 
 

Đây thôn Vỹ Dạ 
 
Sao anh không về chơi thôn Vỹ ​
Nhìn nắng hàng cau nắng mới lên ​
Vườn ai mướt quá xanh như ngọc ​
Lá trúc che ngang mặt chữ điền  

Gió theo lối gió, mây đường mây ​
Dòng nước buồn thiu, hoa bắp lay ​
Thuyền ai đậu bến sông trăng đó ​
Có chở trăng về kịp tối nay?  
Mơ khách đường xa, khách đường xa ​
Áo em trắng quá nhìn không ra ​
Ở đây sương khói mờ nhân ảnh ​
Ai biết tình ai có đậm đà? 

Hàn Mặc Tử. 
Hướng dẫn::  
 Định dạng Font như sau:​Đoạn 1 và đoạn 3: Font: Arial, Size: 12. Left indent (3cm, 9cm) 
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      ​ ​ ​ Đoạn 2: Font: Times New Roman, Size: 12. Left indent = 6cm. 
2.​ Lưu tài liệu vào đĩa D: với tên DayThonVy_buoi2_1.doc. Đóng cửa sổ tài liệu 

đang mở. 
 

●​ FBài làm thêm số 2: 
1.​ Mở File mới và nhập vào bài thơ Ông Đồ Già như dưới đây: 

Ông Đồ Già 
Mỗi năm hoa đào nở ​
Lại thấy ông đồ già ​
Bày mực tàu giấy đỏ ​

Bên phố đông người qua 

Bao nhiêu người thuê viết ​
Tấm tắc ngợi khen tài ​
Hoa tay thảo những nét ​
Như phụng múa rồng bay 

Nhưng mỗi năm mỗi vắng ​
Người thuê viết nay đâu? ​
Giấy đỏ buồn không thắm ​
Mực đọng trong nghiên sầu 

Ông đồ vẫn ngồi đó ​
Qua đường không ai hay ​
Gió buồn mơn mặt giấy ​
Ngoài trời mưa bụi bay 

Năm nay hoa đào nở ​
Không thấy ông đồ xưa ​
Những người muôn năm cũ ​
Hồn ở đâu bây giờ? 

VŨ ĐÌNH LIÊN 
Hướng dẫn: Định dạng Font như sau:  
​ Đoạn 1​​ Font: Times New Roman, Size: 12, chọn gạch dưới (Underline). 
​ Đoạn 2​​ Font: Palatino linotype, Size: 13 
​ Đoạn 3​​ Font: Arial, Size: 12, Strikethrough 
​ Đoạn 4​​ Font: Times New Roman, Size: 12.5 
​ Đoạn 5​​ chọn Format\ Font\ Font: Verdana, Size: 12, underline Style =====. 
2.​ Lưu tài liệu vào đĩa D: với tên OngDoGia_buoi2_2.doc. 
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